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1. What is the shortcut key for the Autosum? 

a. Alt += 

b. Ctrl + = 

c. Shift+Alt 

d. Alt  + Ctrl 

Ans: a. Alt + = 

Explanation: Autosum is a useful feature in Excel that allows you to quickly sum up a range 

of cells. By pressing Alt + =, Excel automatically selects what it determines to be the range 

of numbers you want to sum, typically the contiguous cells above the current cell. Then, 

it inserts the SUM function with the appropriate range as an argument. 

 

2.If the cells A1 and A2 are empty,What will be the value of the following function =A1*A2 

a. Name ?Error 

b. 0 

c. 1 

d. Value Error 

Ans : b. 0 

Explanation: Ctrl + Home is used to Move an active cell to the first column on the current 

row. 
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3 .Which function is used to sum a range of cells in Excel? 

a. AVG() 

b. Max() 

c. SUM() 

d. TOTAL() 

Ans :  c.SUM() 

Explanation: The SUM() function in Excel is used to add up a range of cells. 

 

4. What is the purpose of the AutoSum button in Excel? 

a. It adds up a range of cells 

b. It multiplies a range of cells 

c. It calculates the average of a range of cells 

d. It finds the maximum value in a range 

Ans :  a. It adds up a range of cells 

Explanation: The AutoSum button in Excel is used to quickly add up a range of cells. 

 

5. How can you find and replace data in Excel? 

a. Ctrl + F 

b. Ctrl + H 

c. Ctrl + R 

d. Both A & B 

Ans :  d.Both A & B 

Explanation: You can find and replace data in Excel using Ctrl + F (Find), Ctrl + H(Replace). 
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6.  Which of the following functions is used to find the highest value in a range of cells? 

a. MAX 

b. MIN 

c. AVERAGE 

d. COUNT 

Ans : a. MAX 

Explanation: The MAX function is used to find the highest value in a range of cells. For 

example, =MAX(A1:A10) would return the highest value in cells A1 through A10. 

 

7. Which of the following functions is used to find the average of a range of cells?. 

a. MAX 

b. MIN 

c. AVERAGE 

d. COUNT 

Ans: c. AVERAGE 

Explanation: The AVERAGE function is used to find the average of a range of cells. For 

example, =AVERAGE(A1:A10) would return the average value of cells A1 through A10. 
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8. What is the shortcut key to select all cells in a worksheet in Excel? 

a. Ctrl+A 

b. Ctrl+S  

c. Ctrl+Shift+A 

d. Ctrl+Alt+A 

Ans : a. Ctrl+A 

Explanation: Ctrl+A is the shortcut key to select all cells in a worksheet in Excel. This will 

highlight all cells in the active worksheet. 

 

9. What is the shortcut key to paste values in Excel? 

a. Ctrl+V 

b. Ctrl+Shift+V 

c. Ctrl+Alt+V 

d. Ctrl+P 

Ans :  b. Ctrl+Shift+V 

Explanation: Ctrl+Shift+V is the shortcut key to paste values in Excel. This will paste only 

the values of the copied cells, without any formatting or formulas. 

 

10. What is the shortcut key to select an entire column in Excel? 

a. Ctrl+C 

b. Ctrl+X 

c. Ctrl+Space 

d. Ctrl+Shift+Space 

Ans: c. Ctrl+Space 

Explanation: Ctrl+Space is the shortcut key to select an entire column in Excel. This will 

highlight all cells in the selected column. 
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11. What is the shortcut key to select an entire row in Excel? 

a. Shift+Space 

b. Ctrl+Space 

c. Alt+Space 

d. Ctrl+Shift+Space 

Ans : a . Shift+Space 

Explanation: Shift+Space is the shortcut key to select an entire row in Excel. This will 

highlight all cells in the selected row. 

 

12. What is the shortcut key to open the “Sort” dialog box in Excel? 

a. Ctrl+S 

b. Ctrl+Shift+S 

c. Alt+S 

d. Ctrl+Alt+S 

Ans : d. Ctrl+Alt+S 

Explanation: Ctrl+Alt+S is the shortcut key to open the “Sort” dialog box in Excel. This 

dialog box allows you to sort a range of cells based on one or more criteria. 

 

13. What is the shortcut key to move to the next sheet in an Excel workbook? 

a. Ctrl+Tab 

b. Alt+Tab 

c. Ctrl+Page Down 

d. Alt+Page Down 

Ans : d. Alt+Page Down 

Explanation: Alt+Page Down is the shortcut key to move to the next sheet in an Excel 

workbook. You can use this shortcut key to quickly switch between sheets. 
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14. What is the shortcut key to insert a new row in an Excel worksheet? 

a. Ctrl+R 

b. Alt+R 

c. Shift+R 

d. Ctrl+Shift+R 

Ans: b. Alt+R 

Explanation: Alt+R is the shortcut key to insert a new row in an Excel worksheet. You can 

use this shortcut key to quickly add a new row to your worksheet. 

 

15. What is the shortcut key to insert a new column in an Excel worksheet? 

a. Ctrl+C 

b. Alt+C 

c. Shift+C 

d. Ctrl+Shift+C 

Ans : b. Alt+C 

Explanation: Alt+C is the shortcut key to insert a new column in an Excel worksheet. You 

can use this shortcut key to quickly add a new column to your worksheet. 

 

16.  What is the shortcut key to format cells in Excel? 

a. Ctrl+1 

b. Alt+1 

c. Shift+1 

d. Ctrl+Shift+1 

Ans : a. Ctrl+1 

Explanation: Ctrl+1 is the shortcut key to format cells in Excel. This will open the “Format 

Cells” dialog box, which allows you to format cells in various ways. 
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17. What is the default file name of Microsoft Excel file? 

a. Workbook.xlsx 

b. Workbook1.xlsx 

c. Worksheet.xlsx 

d. Worksheet1.xlsx 

Ans: b. Workbook1.xlsx 

Explanation: The default file name of Microsoft Excel file is "Workbook1.xlsx". 

 

18. What is the column width in a worksheet? 

a. 26 characters 

b. 128 characters 

c. 255 characters 

d. 256 characters 

Ans:  c. 255 characters 

Explanation: The column width in a worksheet is 255 characters. 

 

19. The total number of columns in a worksheet? 

a. 26 

b. 256 

c. 12,834 

d. 16,384 

Ans : d.16,384 

Explanation: The total number of columns in a worksheet is 16,384. 
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20. How many times undo levels can be used in a worksheet? 

a. 25 

b. 50 

c. 75 

d. 100 

Ans: d. 100 

Explanation: There are 100 undo levels in a worksheet. 

 

21. What is the keyboard shortcut to switch between open Excel windows? A tool to fill 

cells with a flash color. 

a. CTRL + TAB 

b. ALT + TAB 

c. CTRL + ALT + TAB 

d. TAB 

Ans: a. CTRL + TAB 

Explanation: The keyboard shortcut to switch between open Excel windows is "CTRL + 

TAB". 

 

22. What is the keyboard shortcut to view formulas instead of values in MS Excel? 

a. CTRL + ` 

b. ALT + ` 

c. CTRL + ALT + ` 

d. CTRL + SHIFT + F 

Ans: a. CTRL + ` 

Explanation: The keyboard shortcut to view formulas instead of values is CTRL + `. 
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23. The currently selected cell address is displayed in ____. 

a. Name Box 

b. Formula Bar 

c. Both A and B 

d. None of the above 

Ans: a. Name Box 

Explanation: Currently selected cell address is displayed in the Name Box. 

 

24. Which feature is used to wrap extra-long text into multiple lines in MS Excel? 

a. Word Wrap 

b. Letter Wrap 

c. Text Wrap 

d. Wrap Text 

Ans: d. Wrap Text 

Explanation: Each cell is identified by a unique combination of its column and row. 

 

25. Which option allows you to display all numbers which are less than 0 (negative 

numbers) in red color in MS Excel? 

a. Styling 

b. Conditional Formatting 

c. Compare Formatting 

d. Special Formatting 

Ans: b. Conditional Formatting 

Explanation: By using the "Conditional Formatting" feature, we can apply special 

formatting based on the conditions. 
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26 Under which menu, we can insert Header and Footer on the sheet? 

a. Format 

b. Review 

c. Data 

d. Insert 

Ans: d. Insert 

Explanation: The header and Footer option is available in the "Insert" Menu. We can insert 

the Header and Footer in the sheet by clicking on the "Header and Footer" option from 

"Text Group" in the "Insert" Menu. 

 

27. The rearrangement of data in ascending (A-Z) or descending (Z-A) orders is called 

_______________ 

a. Filtering 

b. Clear Rules 

c. Sorting 

d. Custom Filter 

Ans: c. Sorting 

Explanation: Sorting is the process of arranging data in a specific order based on certain 

criteria, such as alphabetical order (A-Z or Z-A) for text data or numerical order (smallest 

to largest or largest to smallest) for numeric data. Excel provides sorting functionality 

that allows users to organize their data in a desired sequence, making it easier to analyse 

and interpret. 
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28. When data is arranged in ascending or descending order for only 1 column is called 

__________. 

a. Multiple Column Sorting 

b. One Bar Sorting 

c. Single Column Sorting 

d. None of the above 

Ans: c. Single Column Sorting 

Explanation: This term specifically refers to sorting data in either ascending or 

descending order for only one column. 

 

29. Sorting is done in ___________ ways. 

a. 1 

b. 2 

c. 3 

d. 4 

Ans: b. 2 

Explanation: Ascending Order (A-Z, 0-9): This arranges data from the smallest value to the 

largest value (or from A to Z for text data) in the selected column. 

Descending Order (Z-A, 9-0): This arranges data from the largest value to the smallest 

value (or from Z to A for text data) in the selected column. 
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30. If you wanted to sort by multiple columns or criteria, you would need to click on the 

Sort & Filter command. Which option do you select from the drop-down menu? 

a. Custom Sort 

b. Ascending 

c. Descending 

d. Filter 

Ans: a. Custom Sort 

Explanation: The "Custom Sort" option allows you to specify multiple levels of sorting 

criteria. This means you can sort by one column first, then by another column, and so on, 

to create a custom sorting sequence based on your specific requirements. 

 

31 . Why would you put a filter on your spreadsheet? 

a. To view the top row at all times 

b. To view specific criteria in your spreadsheet 

c. To help with formulas 

d. In order to freeze the columns 

Ans: b.To view specific criteria in your spreadsheet 

Explanation: By putting a filter on your spreadsheet, you can easily view specific criteria 

in your data. This allows you to focus on specific information and analyze it more 

effectively. Filtering helps you narrow down your data based on certain conditions or 

criteria, making it easier to find and analyze the information you need. 
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32.A Relative formula is___? 

a. The same formula but difference cell reference 

b. Anchors the cell reference 

c. Anchors one cell 

d. A function. 

Ans: a. The same formula but difference cell reference 

Explanation: A relative formula refers to a formula that is copied or filled into different 

cells, but the cell references within the formula change accordingly based on their relative 

positions. In other words, the formula remains the same, but the cell references adjust 

relative to the new location. This allows the formula to be applied to multiple cells without 

having to manually adjust each individual reference. 

 

33. What is a validation check? 

a. It is put on to eliminate mistakes 

b. It is a function 

c. A Formula 

d. A condition 

Ans: a. It is put on to eliminate mistakes 

Explanation: A validation check is a process or mechanism put in place to eliminate 

mistakes or errors. It ensures that data or information entered into a system meets certain 

criteria or conditions. By implementing validation checks, potential errors can be caught 

and corrected before they cause any issues or problems. This helps to improve the 

accuracy and reliability of the data being processed. 
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34.What is conditional format? 

a. A Format of colour etc applied to cells to make them standout. 

b. A list in which you can choose from various options 

c. A pattern which you need to set up and drag to cells 

d. A built in pattern 

Ans: a. A Format of colour etc applied to cells to make them standout. 

Explanation: Conditional formatting is a feature in spreadsheet software that allows users 

to apply formatting, such as color, to cells based on certain conditions or criteria. This 

formatting helps to visually highlight specific data or patterns in the spreadsheet, making 

it stand out and easier to interpret. 

 

35.What keyboard key is used with mouse-clicks, to select multiple non-adjacent cells? 

a. Shift 

b. Alt 

c. Ctrl 

d. F1 

Ans :  c. Ctrl 

Explanation: In Microsoft Excel, holding down the "Ctrl" key allows you to select multiple 

non-adjacent cells or ranges within a worksheet. This feature is particularly useful when 

you need to perform operations on several scattered cells simultaneously, such as 

formatting, copying, or deleting data. 
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36.A user wishes to remove a spreadsheet from a workbook. Which is the correct 

sequence of events that will do this? 

a. Go to FILE - SAVE AS - SAVE AS TYPE - Excel 4.0 Work Sheet 

b. Right-click on the spreadsheet tab and select DELETE. 

c. Right-click on the spreadsheet and select INSERT - ENTIRE COLUMN. 

d. Left-click on the spreadsheet and select SAVE. 

Ans: b. Right-click on the spreadsheet tab and select DELETE. 

Explanation: The correct sequence of events to remove a spreadsheet from a workbook 

in Microsoft Excel is to right-click on the spreadsheet tab. 

Select DELETE. 

 

37. On an Excel sheet, the active cell is indicated by ____. 

a. A wide dark border 

b. A dotted border 

c. A blinking border 

d. None of the above 

Ans:  a. A wide dark border 

Explanation: The active cell on an Excel sheet is indicated by a wide dark border. This 

border helps to visually distinguish the currently selected cell from the rest. It is wider and 

darker compared to the borders of other cells, making it easier to identify. The wide dark 

border serves as a visual cue for users to know which cell they are currently working on, 

allowing them to input or edit data accurately. 
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38.To multiply items in Excel, you would use: 

a. @ 

b. * 

c. # 

d. ^ 

Ans: b. * 

Explanation: To multiply items in Excel, you would use the asterisk symbol (*). This symbol 

is used as the multiplication operator in Excel formulas. By placing the asterisk between 

two or more cell references or numbers, Excel will perform the multiplication operation 

and provide the result. 

 

39. How do you sort data in ascending order in Excel? 

a. Click on the header of the column you want to sort and choose "Sort A to Z". 

b. Right-click on any cell in the column and select "Sort & Filter". 

c. Use the "Data" tab on the ribbon and select "Sort" 

d. All of the above 

Ans: d. All of the above 

Explanation: All of the above methods (a, b, and c) are valid ways to sort data in ascending 

order in Excel. 
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40. What is the difference between a relative and an absolute cell reference? 

a.  A relative reference changes when copied, while an absolute reference remains 

the same. 

b.  An absolute reference is used for calculations, while a relative reference is used 

for formatting. 

c. There is no difference; they are the same thing. 

d. Both a and b are correct. 

Ans: a. A relative reference changes when copied, while an absolute reference remains the 

same. 

Explanation: Relative references: These references are based on the relative position of 

the cell containing the reference and the cell being referenced. When you copy a cell 

containing a relative reference, the reference automatically adjusts to maintain the same 

relative position. On the other hand, Absolute references use dollar signs ($) to lock the 

row and/or column of the referenced cell. When you copy a cell containing an absolute 

reference, the reference remains the same, regardless of the new location. 

 

41 What is the purpose of conditional formatting in Excel? 

a. To format cells based on certain criteria. 

b. To add borders and shading to cells. 

c. To create charts and graphs. 

d.  To merge and centre cell contents 

Ans:  a. To format cells based on certain criteria. 

Explanation: While conditional formatting can indeed be used to add borders and shading 

to cells, that's not its primary purpose. This visual highlighting helps you quickly identify 

important trends and outliers in your data. 

 

42.Which of the following is the correct formula for the IF function in Excel? 



 
Name of the Bundle Office Productivity  Bundle V2 (2024) Subject MS Excel 

Topic Editing ,Formatting in Excel 
Workbook 

Last updated on 06 April 2024 

 

IT Support and Development Training Programme  
Creating Employable Engineers and Entrepreneurs  

 

a. IF (logical_test, value_if_true, value_if_false) 

b. =IF (logical_test, value_if_true, value_if_false) 

c. =(logical_test, value_if_true, value_if_false) 

d. all of these 

Ans: b. =IF (logical_test, value_if_true, value_if_false) 

Explanation:  The correct syntax for the IF function in Excel is: =IF(logical_test, 

value_if_true, value_if_false) 

logical_test: This is a logical expression or condition that you want to test. If this condition 

evaluates to TRUE, the function returns the value_if_true. 

value_if_true: This is the value that the function returns if the logical_test evaluates to 

TRUE. value_if_false: This is the value that the function returns if the logical_test 

evaluates to FALSE. 

 

43.A formula that uses the COUNTIF function is broken into two pieces. What are they? 

a. If and Count 

b. Range and Criteria 

c. Operators and Symbols 

d.  Functions and Calculations 

Ans: b. Range and Criteria 

Explanation: when you use the COUNTIF function, you are essentially specifying two 

pieces of information: the range of cells to examine and the criteria that Excel should use 

to determine which cells to count. 
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44.If you wanted Excel to look in B3 through B10 and find text equal to cookie, which 

formula would be correct? 

a. =COUNTIF(B3:B10,cookie) 

b. =COUNTIF(B3:B10,&cookie) 

c. =COUNTIF(B3:B10=cookie) 

d. =COUNTIF(B3:B10,''cookie'') 

Ans: d. =COUNTIF(B3:B10,''cookie'') 

Explanation: =COUNTIF(B3:B10,"cookie"), as it correctly utilizes the COUNTIF function to 

count cells containing the text "cookie" in the specified range of cells. 

 

45.If you wanted Excel to look in cells C4 through C24 and find all numbers that are 

greater than or equal to 10, which formula would be correct? 

a. =COUNTIF(C4:C24,''>=''&10) 

b. =COUNTIF(C4:C24,”>='10'') 

c. =COUNTIF(C4:C24,''>=''10) 

d. =COUNTIF(C4:C24,>=&10) 

Ans: b. =COUNTIF(C4:C24,”>='10'') 

Explanation: The COUNTIF function is used to count the number of cells within a range 

that meet a specified condition. it correctly utilizes the COUNTIF function to count the 

numbers greater than or equal to 10 in the specified range of cells. 
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46.Which formula would find the largest number in the range? 

a. =MIN(D3:D12) 

b. (MAX(D3:D12)) 

c. =MAX(D3:D12) 

d.  =IF(D3:D12) 

Ans:  c. =MAX(D3:D12) 

Explanation: Max function to find the Largest number within the specified range of cells. 

 

47.Which formula is an example of finding the smallest number in a range? 

a. =MIN(D3,D6,D10) 

b. =MIN(D3:D13) 

c. =MIN(D3,D6,50,3) 

d. =MIN(B14:B16,D3,4) 

Ans : b. =MIN(D3:D13) 

Explanation: MIN function to find the smallest number within the specified range of cells. 

 

48.Which command will you choose to convert a column of data into row ? 

a. Edit >> Paste Special >> Transpose 

b. Cut and Paste 

c. File>>Insert>>Transpose 

d. All of the above 

Ans :  a. Edit >> Paste Special >> Transpose 

Explanation: This command allows you to convert a column of data into a row by changing 

its orientation using the "Transpose" option under "Paste Special." 
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49.Which of the cell pointer indicates that you can fill series ? 

a. small thin plus icon 

b. Mouse Pointer with anchor at the tip 

c. Doctor symbol (Big Plus) 

d. Arrow mark 

Ans :  a. small thin plus icon 

Explanation: It indicates that Excel recognizes a pattern in the selected cells and allows 

you to fill a series by dragging the fill handle across adjacent cells. 

 

50.You can auto fit the width of column by 

a. Double clicking on the column left border of column header 

b. Double clicking on column right border on column header 

c. Double click on the cell pointer in worksheet 

d. double clicking on the column name on column header 

Ans :  b. Double clicking on column right border on column header 

Explanation: Double-clicking on the column right border on the column header. This action 

triggers Excel to auto-fit the width of the column to the widest content within that column. 
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51.MS Excel provides the default value for step in Fill Series dialog box 

a. 10 

b. 5 

c. 1 

d. 0 

Ans :  c. 1 

Explanation: The default step value in Excel's Fill Series dialog box is typically 1. This 

means that if you leave the step value field blank or do not change it, Excel will 

automatically fill the series with increments or decrements of 1. 

 

52.The short cut key Ctrl + R is used in Excel to 

a. Remove the cell contents of selected cells 

b. Fill the selection with active cells to the right 

c. Right align the content of cell 

d. Delete a cell. 

Ans :  b. Fill the selection with active cells to the right 

Explanation: Ctrl + R is a shortcut for the "Fill Right" command in Excel. When you select 

a range of cells and use this shortcut, Excel fills the selected cells with the content of the 

cell immediately to their left. 
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53.Which formula is correct if you want to add the numbers in cells B3 and B4? 

a. =sum(B3+B4) 

b. =sum(B3...B4) 

c. =sum(B3*B4) 

d. =sum(B3-B4) 

Ans :  a.=sum(B3+B4) 

Explanation: The formula =SUM(B3+B4) accurately adds the numbers contained in cells 

B3 and B4 in Excel. 

 

54.Which is the best View to adjust how much prints on each page? 

a. Normal 

b. Page Break Preview 

c. Print Preview 

d. Full Screen 

Ans :  b.Page Break Preview 

Explanation: when working with Microsoft Excel, the "Page Break Preview" view offers the 

best tools and visualizations for adjusting how much content prints on each page, making 

it easier to create well-formatted and readable printouts of your spreadsheet data. 

 


